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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the 
safe and accurate exchange of information, enabling the collaborative evolution of high 
value business documents. 

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook

 Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending 
emails.

What’s New in Workshare Professional 10.4

The Professional 10.4 release includes the following:

 Toolbar options on Litera tab

All the Workshare options, previously located on a Workshare tab in Microsoft 
Office applications, can now be found on a Litera tab.

Note: Toolbar options are now implemented using XML files which gives 
administrators more freedom when customizing ribbons.

 Kofax OmniPage for OCR

Customers can select to use Kofax OmniPage to perform optical character 
recognition to change a scanned PDF from an image to text, and then convert it to 
RTF for comparison. This is enabled using a configuration option.

 Improved detection of changes in images

By default, Compare detects if an image has been inserted or deleted. Now, 
Compare can also detect changes to the image itself. This pixel-by-pixel 
comparison is enabled using an option in the Rendering Set Manager (Comparison 
Options). The parameter “Detect changes to images” has been changed to “How to 
detect changes to images” and this parameter has the following three options:

 Insertions/deletions (default) – as before

 Pixel-by-pixel – new

 Do not compare
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 Online functionality removed from Compare and Protect standalone 
installations

The Connect module has been removed from the Protect and Compare standalone 
installs.

 Assorted bug fixes

Environment changes

 Added support for cloudimanage.com

This is also referred to as iManage multi-tenant cloud or iManage elastic cloud. 
Customers will need to register cloudimanage.com as their iManage server in the 
Workshare Configuration Manager and also install a Registry key.

Workshare Configuration Manager

The following parameter was added:

 Use Kofax OmniPage to perform OCR and conversion (Comparison > 
Administration)

The following parameter was removed:

 Add Workshare Compare group to the Litera Desktop ribbon in Microsoft 
Office (General > User Interface)

System Requirements

The recommended system requirements for Workshare Professional 10.4 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare Professional 10.4 has a 32-bit version for 32-bit Microsoft Office environments 
and a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Professional 10.4
(32-bit version)

Workshare Professional 10.4 (32-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

mailto:support@workshare.com
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For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop)

 Microsoft Office 2019 (32 bit) – including click-to-run

 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version
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 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Professional 10.4
(64-bit version)

Workshare Professional 10.4 (64-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
mailto:support@workshare.com
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For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert 
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Professional does not support Outlook when it is configured with 
a POP or IMAP account.

Important installation information

 Workshare Professional installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
https://www.microsoft.com/en-us/download/details.aspx?id=25
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 Windows 7: When UAC is set to Default, running the Workshare Professional 
install displays the UAC prompt. You must approve the prompt and Workshare 
Professional will be installed. Running the Workshare Professional MSI silently will 
fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly 
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

Ref CR Description

PRO-815 01062255 Combine PDF not picking up changes made after saving 
open document to iManage

PRO-2342 01161036 Replies to comments in Word are detached when lightspeed 
clean option is enabled 

PRO-2861 01162284 Error message when converting Word document to PDF: 
Unable to convert to PDF: The object invoked has 
disconnected from its clients. (Exception from HRESULT: 
0x80010108 (RPC_E_DISCONNECTED))

CMP-62 01163333 Links in Excel documents are detected again even after 
removal

PRO-2771 01164177 Actioning a message found using Outlook Advance find 
produces an error with Workshare Ribbon Add-in Enabled

PRO-2812 01164429 Compare for Excel appears to hang on a specific sheet in 
workbook

PRO-3528 01169160 Compare for Excel takes 45 minutes to compare a set of 
files

PRO-3709 01169986 Compare for Excel hangs when comparing attached 
spreadsheets

PRO-3753 01170892 After running Compare for Excel user is unable to browse 
cells in the TER view comparison

PRO-3814 01172085 Compare for Excel fails to complete in a timely manner

PRO-3825 01172216 Compare for Excel crashes/hangs when comparing attached 
files

PRO-3689 01172368 0 kb' file is generated when printing the redline with 'Nuance 
PDF' as default printer from the workshare Compare.



Workshare Professional 10.4 Release Notes

11

Ref CR Description

PRO-3950 01173441 Excel Comparison fails to export after a successful 
comparison is completed if spreadsheet contains a Large 
number of Rows and Special formatting

PRO-3952 01173470 "Printer not activated, error code -30" when printing 
comparison to PDF using the Workshare PDF Publisher 
printer

PRO-3982 01173788 Blank email created in 'Drafts' folder when Interactive 
Protect is enabled

PRO-4049 01173819 .NET Framework error occurs when launching Outlook if 
Workshare is not licensed

PRO-4250 01174274 Compare only populates the modified field with an Appdata 
file path when selecting the 'Save and Sync' option from the 
iManage tab in Word

PRO-4251 01174979 Compare for Excel comparison takes almost 10 minutes to 
complete

PRO-4255 01175163 Word document when processed with lightspeed clean is 
corrupted

PRO-4466 01176343 Documents using Simplified Chinese have Redlines 
incorrectly showing as all modified or deleted when using 
Compare for Excel

CMP-311 00317423 Incorrect path specified in Document Selection Screen when 
comparing iManage documents from Word

PRO-5174 01178546 Error: "Workshare 10.0 was unable to retrieve the Modified 
source document" when comparing an unsaved document 
from Word

PRO-4369 404 Error when connecting to or browsing for files in 
cloudimanage.com

CMP-70 Blank table cells in a row are shown as inserted and deleted 
rather than matched 

CMP-71 Text is lost when reading nested tables from Doc file format 

CMP-73 Missing text in nested table comparison output

CMP-74 Table shape is not preserved for unchanged/wholly 
deleted/wholly inserted tables 

CMP-75 Inserted or deleted table columns are not identified correctly 
– different inserted or deleted cells in some rows

CMP-78 Table cells are shown as merged when no merging has 
occurred 

CMP-80 Tables in the redline document are split into three or more 
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Ref CR Description

sections which are placed incorrectly 

CMP-83 Blank table rows are not paired with non--blank rows from 
the other document 

CMP-84 Content change within cells is being shown as insert and 
delete of cells instead of a cell with deleted and inserted text

CMP-89 Diagonal borders and redline slope in wrong direction 

CMP-90 Space between tables lost in red line output file 

CMP-91 Incorrect comparison where there are complicated merged 
cells in both documents 

CMP-112 Remove Connect from Compare only

CMP-113 Remove Connect from Protect only

CMP-254 Incorrect text 'NetDocuemnts' is displayed instead of 
'NetDocuments' on Professional  MSI installer dialog.

Known Issues

The following are known issues in the Workshare Professional 10.4 release - for more 
information, please contact Customer Support.

Ref Description

CMP-411
The Send to > Workshare Batch Clean right-click option is not available 
after installing using Active Directory.

CMP-98
There may be some formatting issues in the comparison after comparing 
documents with 'Use Kofax OmniPage for OCR and conversion' enabled in 
the rendering set.

PRO-3843

01171983

Document specific: Specific Word documents are taking 3-5 minutes to 
compare. (CMP-290)

PRO-3449

01168494

The error "System.Threading.ThreadAbortException" may be displayed 
when saving a redline as attach/relate to original/modified document in 
OpenText DM 16.5. (CMP-295)

PRO-3409

01168025

iManage integration: After an upgrade, the recent files list in Compare’s 
Document Selection dialog retains the recent files compared prior to the 
upgrade. However, you are not able to compare those recent iManage files 
because the path is shown as “interwovenSite://…” rather than 
“iManage://…”.

PRO-3137

01166593

When cleaning metadata from a PowerPoint attachment with the lightspeed 
clean option enabled, the slide animation sequence may be removed.
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Ref Description

PRO-2513
Errors can occur when using Selective Compare if Compare dialogs are 
open and the "Launch new comparison in running instance" configuration 
option is enabled.

PRO-1387 Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row is 
empty.

PRO-1386 Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019 Compare for Excel: Focus is not completely applied to the last change in the 
comparison window if the user clicks the Last Change button for the first 
time.

PRO-837
01061816

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned. (CMP-25)

PRO-792
01088791

After running a comparison in Workshare Compare, some line numbering 
and table text and row cells maybe be missing.

PRO-528 IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when 
the email is processed through desktop profiles or all mail profiles. This is an 
issue with IBM Notes.

PRO-527 IBM Notes only. Attachments are not automatically compressed to a zip file 
when the limit specified in the WCM is reached.

PRO-525 The positioning of signature components in RTF format emails can be 
incorrect after processing with Protect.

PRO-109
01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22 The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100 The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577 Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01018743 The font in the email body changes to Times New Roman when sending 
attachments to groups in Interactive Protect.

01028440 Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

http://www-10.lotus.com/ldd/fixlist.nsf/8ed1b46cfdba8957852570c90054623b/dbf1eb80caf496f0852580d800738d12?OpenDocument
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Ref Description

40418 When comparing particular presentations, 'Index was outside the bounds of 
the array' error is displayed.

40430 When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469 In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574 A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597 The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284 In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547 When a PowerPoint presentation is run from the command line, the incorrect 
comparison theme is highlighted under the Select dropdown in the Home 
ribbon.

45583 When a machine is restarted before the convert to link process has 
completed, files which are not synced are moved to a conflict state in the 
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy 
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help 
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective 
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27/3/19
Revised for Workshare Professional 10.1 Revision 1: 16/5/19
Revised for Workshare Professional 10.2: 28/6/19
Revised for Workshare Professional 10.2 Revision 1: 19/8/19
Revised for Workshare Professional 10.3: 2/10/19
Revised for Workshare Professional 10.4: 09/12/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
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